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Introduction

The purpose of this user manual is to demonstrate the main points of using SharpShooter Reports.Silverlight
software and provide necessary knowledge for getting started with the component. You will get step by step
recommendations on how to create a web application using SharpShooter Reports.Silverlight. You will also
look into the process of creating and configuring a service, designing a report and, finally, integrating a report
viewer into the application pages.

Product Prerequisites

In order to get the sample working the following software should be installed on your computer:

MS Visual Studio 2012

.NET Framework 4.5

ASP.NET 2.0

Silverlight 5.0

Microsoft Silverlight 5 Toolkit

SharpShooter Reports.Silverlight 6.0.0.0 or higher.

Creating a Sample Application
Step 1. Creating a Project

1) To begin with, we should create a new Silverlight Application project in MS Visual Studio.

0 Microsoft Visual Studio
FILE EDIT VIEW DEBUG TEAM TOOLS TEST ARCHITECTURE .NETREFLECTOR ANALYZE WINDOW

(i) A

Web Site... Shift+Alt+N

Open roig
¢ T#  Team Project...
‘O File.. Ctrl+N
Project From Existing Code...
u¥  SaveAll Ctrl+Shift+5
Source Control »
Recent Files »
Recent Projects and Solutions ’
B Exit Alt+F4
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2) Let’s call our project a ‘SilverlightApplication’

b Recent .NET Framework 4.5 ~ Sort by: Default M
4 |nstalled (3
@ Silverlight Application N Visual C#
4 Templates o
4 Visual C# en!! Silverlight Class Library Visual C#
Windows Store
2 (5
Windows @ Silverlight Business Application Visual C#
Web
o Cc#
b Office @ Silverlight Navigation Application Visual C2
Cloud
R ft c#
cporting é!! WCF RIA Services Class Library Visual C#
b SharePoint
Silverlight
Test
WCF
Windows Phone
Workflow
LightSwitch

b Other Languages
b Other Project Types
Modeling Projects

Samples
P Online
Name: | [Siiveriightapplication I
Location: C:\Getting Started\ v.
Solution name: SilverlightApplication

3) While creating a project we should check ‘Host the Silverlight application in a new Web site’ option
and set the name of the web-project to ‘SilverlightApplication.Web’. Additionally, don’t forget to
specify ‘Silverlight 5’ version as a targeted platform.

Click the checkbox below to host this Silverlight application in a Web site. Otherwise, a
test page will be generated during build.

Host the Silverlight application in a new Web site

New Web project name:

'SilverlightApplication.Web

New Web project type:

} ASP.NET Web Application Project

Options
Silverlight Version:

‘Silverlight 5

N
b
[] Enable WCF RIA Services
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4) A new Visual Studio solution will be created after that. It will contain two projects: client side
‘SilverlightApplication” and server side ‘SilverlightApplication.Web’.

L@l Solution Explorer v X
P @ o-2udnd #R|R -
Search Solution Explorer (Ctrl+;) P~

fa] Solution 'SilverlightApplication’ (2 projects)
b & SilverlightApplication
b [z SilverlightApplication.Web

Step 2. Configuring Server Side Part

1) Setthe web application to use static port 5555. To do this, open SilverlightApplication.Web properties

Al Solution Explorer
2 @ o-2udnd *RAZ -
Search Solution Explorer (Ctrl+;)

&1 Solution ‘SilverlightApplication’ (2 projects)

% Build b & SilverlightApplication
Rebuild b [zl SilverlightApplication.Web
Clean

€ Publish..

Run Code Analysis

View in Browser

|

Convert to Web Application
View in Page Inspector Ctrl+K, Ctrl+G
Check Accessibility...

ar
&)
Open Command Prompt
=
2

Edit Project File olution Explorer  Team Explorer
Copy As Project Reference roperties
*{} Remove and Sort Usings SilverlightApplication.Web Project Properties
Copy Path
Scope to This Always Start When Debuggil True
New Solution Explorer View Anonymous Authentication Enabled
Calculate Code Metrics Managec»i Pipeline Mode Integrated
Project File SilverlightApplication.We
Project Dependencies... Project Folder C:\Getting Started\Silverl
Project Build Order... SSL Enabled False
:l Add N SSL URL
o Add Reference.. URL http://localhost:8110/
5t . Windows Authentication  Disabled
o Add Service Reference...
B Manage NuGet Packages...
b %3 View Class Diagram
¢ £ Setas StartUp Project
Debug 4
¥@ Add Solution to Source Control... Always Start When Debugging
% cut CtrleX tart the local Web server even when not the startup pro
X  Delete Del
= ‘Rename Search Error List
Unload Project Line Column Project

¢ Open Folder in File Explorer

| 5 Propetis [y AvEte
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2) Check ‘Specific port’ option and set ‘5555’ as a value in the Web tab of the SilverlightApplication.Web
properties.

Application
i 5 ) r N/A
N/A
Package/Publish Web
Start Action A
Package/Publish SQL
Silverlight Applications O Current Page
Build Events (®) Specific Page SilverlightApplicationTestPage.aspx
Resources (C) Start external program
Settings
Command line arguments
Reference Paths
Signing Working directory
Code Analysis () Start URL

() Don't open a page. Wait for a request from an external application.

Servers

Apply server settings to all users (store in project file)

(®) Use Visual Studio Development Server

() Auto-assign Port

(®) Specific port N |5555

Virtual path: /
[[] NTLM Authentication

() Use Local IIS Web server
| Use [IS Expres

Project Url: http://localhost:8110/

Step 3. Adding and Setting Up a WCF Service

1) Inorder to make the client interact with the server, we need a special service. Before we create this
service we need to add a reference to ‘PerpetuumSoft.Reporting.Silverlight.Server.dll’. Right-click
‘References’ node in the SilverlightApplication.Web project and choose ‘Add Reference’ in the popup

menu.
L ISRl Solution Explorer v
< v, e 0
o @ e-2udBd *RR -
ilver a
» Search Solution Explorer (Ctrl+;) el

&1 Solution ‘SilverlightApplication' (2 projects)
b :@ SilverlightApplication
4 SilverlightApplication.Web

b S Properties

¥ LH L Eet

Add Service Reference... !!

B Manage NuGet Packages... esthageaspx
estPage.html

53 Copy References
Scope to This
New Solution Explorer View
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This will open a ‘Reference Manager’. In order to add a correct library version reference we should browse
the \Bin folder of the installed product and find ‘PerpetuumSoft.Reporting.Silverlight.Server.dll’ in it.

Pt Search Browse (Ctrl+E) P~
b Solution
b COM No items found.

4 Browse

Recent

T | « SharpShooter Collection » Bin v & Search Bin

Organize v New folder

,
Name File version

¢ Favorites |%] PerpetuumSoft.Reporting.Export.Pdf[OldVersion]...  6.5.0.86
B Desktop |%| PerpetuumSoft.Reporting.Export.Rtf.dll 6.5.0.86
& Downloads %) PerpetuumSoft.Reporting.Export.Xps.dll 6.5.0.86
2 Recent places %, PerpetuumSoft.Reporting.Import.ActiveReports.dil ~ 56.5.0.26
%] PerpetuumSoft.Reporting.Import.CrystalReports.dil ~ 5.5.0.26
. Libraries %] PerpetuumSoft.Reporting.MSChart.dll 6.5.0.86
[=] Documents %, PerpetuumSoft.Reporting.Silverlight.Server.dIl 6.5.0.86
Js Music %) PerpetuumSoft.Reporting.Web.dll 6.5.0.86
[=| Pictures %] PerpetuumSoft.Reporting.Web.WebReportViewer....  6.5.0.86
B videos |%| PerpetuumSoft.Reporting.WebViewer.Client.dll 1.0.0.0
5 PerpetuumSoft.Reporting.WebViewer.Client.Mod...  1.0.0.0
1% Computer %] PerpetuumSoft.Reporting.WebViewer.Model.dll 1.0.0.0
a Local Disk (C:) %) PerpetuumSoft.Reporting.WebViewer.Server.dll 6.5.0.86

|%| PerpetuumSoft.Reporting.WebViewer.ServerMvc....  1.0.0.0

e! Network %) PerpetuumSoft.Reporting. WPF.dlI 6.5.0.86

[0 P e ke € e P e ekl e Vel Fecee a1 ccnnc
1M AFANASYEVA vl 52 >

A

File name: | PerpetuumSoft.Reporting.Silverlight.Se v‘ lComponent Files (*.dI;*.tlb;*.0l v,

| A ]| Ccancel \




2) After that, we should add a Report Service Over HTTP template to the SilverlightApplication.Web

project.

In order to do that, right-click SilverlightApplication.Web project and choose Add->New Item in the popup

menu.

Build

Rebuild

Clean

Publish...

Run Code Analysis

.E‘

Q@

il

View in Browser

Convert to Web Application
View in Page Inspector
Check Accessibility...

Open Command Prompt
Collapse Project

Edit Project File

Ev R IIIIEI n @%

Copy As Project Reference

21
-
—

Remove and Sort Usings
Copy Path

Scope to This

New Solution Explorer View
Calculate Code Metrics

Project Dependencies...
Project Build Order...

Add Reference...
Add Service Reference...

W o= % T

B  Manage NuGet Packages...
4 #3  View Class Diagram
L} Set as StartUp Project

Select the Report Service Over HTTP (Silverlight & WinRT) template and specify name of the service as
‘ReportServicel.svc’. Then click ‘Add’ button.
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Al Solution Explorer 4

® e-2udnm »F

Search Solution Explorer (Ctrl+;)

Ctrl+K, Ctrl+G

4 Installed Sort by: Default

4 Visual C#

Code

Data

General

Web

Windows Forms

WPF

Reporting

SharpShooter Reports
Reports Template
Silverlight 8& WinRT
Web

Silverlight

SVforRS

Workflow

b Online

Name: ReportServicel.svc

A
/"- Report Service Over HTTP (Silverlight & WinRT) Visual C#

ion 'SilverlightApplication’ (2 projects)
ilverlightApplication

ilverlightApplication.Web
Properties
References
m ClientBin
I Silverlight.js
1 SilverlightApplicationTestPage.aspx
) SilverlightApplicationTestPage.html
2 Web.config

xplorer | Team Explorer

itApplication.Web Project Properties
¥

Start When Debuggii True
mous Authentication Enabled

ed Pipeline Mode  Integrated

File SilverlightApplication.Web.
Folder C:\Getting Started\Silverlig
bled False

I ey <

‘3  Existing ltem... Shift+Alt+A
‘i New Folder
Add ASP.NET Folder »
Web Form

Web User Control

Search Installed Templates (Ctrl+E)

Type: Visual C#

LS

)
é Report Service Over HTTPS (Silverlight & WinRT)  Visual C#
bl

P~
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The ReportService class will extend the PerpetuumSoft.Reporting.Silverlight.Server.ReportServiceBase
class containing implementation of WCF Service for Silverlight ReportViewer.

Step 4. Creating a Report Template

1) First of all we need to create a data source structure. In order to do that, right-click
ReportServicel.svc.cs and choose View Designer in the popup menu.

Solution Explorer v 1
@ o-2udd o R -
Search Solution Explorer (Ctrl+;) ol

fa Solution 'SilverlightApplication' (2 projects)
b 1@/‘ SilverlightApplication
4 T[] SilverlightApplication.Web
b S Properties
p =B References
B ClientBin
4 :® ReportServicel.svc

¢ Open
Open With...
b Open Command Prompt
[Z# Open Containing Folder

Soluti 53 Copy Class

Copy Path
Prope £ X

R <> View Code F7
epo

o= |:g

‘Q View Class Diagram
Bro
Bui Scope to This

Co New Solution Explorer View
Cu: X Delete Del
Cut

‘u &  Properties Alt+Enter
File <
Full Path C:\Getting Started\SilverlightAp)

2) To populate our sample application with the data we add a Dataset control from the Toolbox by
double click on it.
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Toolbox v 1 x

Search Toolbox P~

b All Windows Forms
P Common Controls

b Containers
P Menus & Toolbars

4 Data
k  Pointer
i Chart

"  BindingNavigator

@ BindingSource
@ DataGridView

Components
s DataSet
b Printing Version 4.5.0.0 from Microsoft Corporation
b Dialogs .NET Component

b Reporting
(S Shavahooter Dashl Represents an in-rnemory cache of data.

b SharpShooter Gauges To add components to your class, drag them from the Toolbo

b SharpShooter OLAP to set their properties. To create methods and events for yo
b SharpShooter Charts code view.

b SharpShooter Reports
b WPF Interoperability
b Visual Basic PowerPacks

4 General

There are no usable controls in this group.
Drag an item onto this text to add it to the
toolbox.

3) Inthe opened window we select the ‘Untyped’ dataset to simplify the process of adding data to our
sample.

Choose a typed or untyped dataset to add to the designer.
() Typed dataset

Name:

Creates an instance of a typed dataset class already in your project. Choose this option to work
with a dataset that has a built-in schema. See Help for details on generating typed datasets.

(®) Untyped dataset

Creates an instance of an untyped dataset class of type System.Data.DataSet. Choose this option
when you want a dataset with no schema.

Cancel

After that the dataset node (dataSet1) will appear in the designer.

D‘ SilverlightApplication - Microsoft Visual Studio
FILE EDIT VIEW PROJCT BUILD DEBUG TEAM TOOLS TEST ARCHITECTURE .NET REFLECTOR

Q- B - 92 - - P Google Chrome ~ Debug ~ A _
Toolbox + g v X
Search Toolbox P~ PR
b All Windows Forms L-EdataSeﬂ

b Common Controls
P Containers

P Menus & Toolbars
4 Data

Pointer %
Chart

BindingNavigator

BindingSource

DataGridView

DataSet

CETGEy

b Components
b Printing
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4) Next, open a Tables Collection Editor (by clicking E] button on the right of the Tables property).

Properties v X
dataSet1 System.Data.DataSet v
=[][D]F &

(Name) dataSet1

CaseSensitive False

DataSetName NewDataSet

EnforceConstraints True

GenerateMember True

Locale Russian (Russia)

Modifiers Private

Namespace

Prefix

Relations (Collection)

RemotingFormat Xml

I Cotection) ]

A

5) Add ‘Customers’ table to the dataSet1 (click “Add” button and set ‘TableName’ property value to
‘Customers’ and ‘Name’ property value to ‘customers’).

Members: Customers Properties:

0 Comomer: | + Daa

Columns (Collection)
Constraints (Collection)
DisplayExpression
MinimumCapacity 50
Namespace

Prefix

PrimaryKey DataColumn(]
TableName Customers
Design

(Name) customers

GenerateMember  True
Modifiers Private
Misc

CaseSensitive False

v

Close

6) After that, open a Columns Collection Editor (by clicking E] button on the right of the Columns
property) and add two columns by clicking ‘Add’ button and setting ‘ColumnName’ property value to
‘Name’ and ‘Phone’.
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Members: Column1 Properties:

0| Name 4 Data
1 AllowDBNull True

Autolncrement False

AutolncrementSeed 0
AutolncrementStep 1

Caption Column1
ColumnName Phone I
DataType System.String
DateTimeMode UnspecifiedLocal
DefaultValue <DBNull>
Expression

MaxLength -1

Namespace

Prefix

ReadOnly

7) Now we have data structure defined and it’'s necessary to fill our sample ‘Customers’ table with the
data itself. Since the data of our sample table will be populated programmatically we need to switch to
source code view by right clicking the designer area and selecting ‘View Code’ item in the contextual
menu.

3 Cut Ctrl+X
ol Copy Ctrl+C
Paste Ctel+V
Paste Special 4
X  Delete Del
& Properties

8) Add the following namespaces to your code

System.Collections.Generic
System.Data
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~ ReportServicel.svees® & X [ReportSenvicel..veics[Design]s | ¥
#3 SilverlightApplication.Web.ReportService1 ~ @, customers
Flusing System.ServiceModel.Activation;

b bl

using PerpetuumSoft.Reporting.Silverlight.Server;
| bsing System.Collections.Generic;
| using System.Data; I

=Inamespace SilverlightApplication.Web
{

[AspNetCompatil

= public class Repor

{

yRequirements(RequirementsMode = AspNetCompati

Servicel : ReportServiceBase

yRequirementsMode

private System.Data.DataTable customers;
private System.Data.DataColumn dataColumnl;
private System.Data.DataColumn dataColumn2;
private System.Data.DataSet dataSetl;

= public ReportServicel()
InitializeComponent();

= public veid InitializeComponent()
{

this.dataSetl = new System.Data.DataSet();
this.customers = new System.Data.DataTable();
this.dataColumnl = new System.Data.DataColumn();
this.dataColumn2 = new System.Data.DataColumn();
((System.ComponentModel.ISupportIni )(this.dataSetl)).BeginInit();
((System.ComponentModel.ISupportInitialize)(this.customers)).BeginInit();
/7
// dataSetl
/7
this.dataSetl.DataSetName = "NewDataSet";
this.dataSetl.Tables.AddRange(new System.Data.DataTable[] {
this.customers});
/7
// customers
/7

9) Now we will fill in the values via overriding OnLoadData method of the ReportService class.

protected override void OnLoadData(IDictionary<string, object> parameters, string reportName,
PerpetuumSoft.Reporting.Components.ReportSlot reportSlot)
{

base.OnLoadData(parameters, reportName, reportSlot);

DataRow row = customers.NewRow();

row[ "Name"] = "Johnson Leslie";

row[ "Phone"] = "613-442-7654";

customers.Rows.Add(row);

row = customers.NewRow();

row[ "Name"] = "Fisher Pete";

row[ "Phone"] = "401-609-7623";

customers.Rows.Add(row);

row = customers.NewRow();

row[ "Name"] = "Brown Kelly";

row[ "Phone"] = "803-438-2771";

customers.Rows.Add(row);
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 Reponsenicetvces = iSRRG ORES .

4 SiIvevlightAppIication.Web.RepodSé&icﬂ S Q, OnLoadData(IDictionary<string, object> parameters, string -]
// customers =
/7 N

this.customers.Columns.AddRange(new System.Data.DataColumn[] {
this.dataColumnl,

this.dataColumn2});

this.customers.TableName = "Customers”;

/7

// dataColumnl

/7

this.dataColumnl.ColumnName = "Name";

/7

// dataColumn2

/7

this.dataColumn2.ColumnName = "Phone”;
((System.ComponentModel.ISupportInitialize)(this.dataSetl)).EndInit();
((System.ComponentModel.ISupportInitialize)(this.customers)).EndInit();

=] protected override void OnlLoadData(IDictionary<string, object> parameters, string r
{
base.OnLoadData(parameters, reportName, reportSlot);
DataRow row = customers.NewRow();
row["Name”] = "Johnson Leslie";
row["Phone”] = "613-442-7654";
customers.Rows.Add(row);
row = customers.NewRow();
row["Name"”] = "Fisher Pete";
row["Phone”] = "4@1-6@9-7623";
customers.Rows.Add(row);
row = customers.NewRow();
row["Name”] = "Brown Kelly";
row["Phone”] = "883-438-2771";
customers.Rows.Add(row); I

Note: Information about the queried document and its parameters is passed in the method's parameters.

10) Now add the ‘ReportManager’ component (by double clicking ‘ReportManager’ on the ToolBox). This
component is responsible for report generation.

Toolbox v 1x X

B2

Search Toolbox P~

b Printing - [29] dataSet1 _
b Dialogs
b Reporting

b SharpShooter Dashboards
b SharpShooter Gauges
P SharpShooter OLAP
b SharpShooter Charts
4 SharpShooter Reports
k Pointer

ReportManager
' D Lo

esignerDataSourcesTree

(i

G lg

DesignerDocumentTree

@ DesignerErrorList
E DesignerPropertyGrid

After that the ReportManager node (reportManager1) will appear in the designer.

o7 dataSet1 . reportManagerl

s
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11) Set the ReportManager property of the ReportService service. In order to do that, open ReportService
properties in the Properties window.

i ClientBin

4 :® ReportServicel.svc
b %) ReportServicel.sve.cs
LT Silverlight.js

BN O o R oA B o o o o e T o b o m e

Solution Explorer  Team Explorer

Properties

reportManager1 PerpetuumSoft.Reporting.Components.ReportManager
customers System.Data.DataTable

dataColumn1 System.Data.DataColumn

dataColumn2 System.Data.DataColumn

dataSet1 System.Data.DataSet

reportManager1 PerpetuumSoft.Reporting.Components.ReportManager
ReportServicel PerpetuumSoft.Reporting.Silverlight.Server.ReportServiceBase k

OwnerForm (none)
ParentContainer (none)
Reports (Collection)

And select reportManagerl from the list.

i ClientBin

4 :=® ReportServicel.svc
b 1) ReportServicel.svc.cs
LT Silverlight.js

3 . R S O R S R, e e S

Solution Explorer | Team Explorer

Properties v o Xx

ReportServicel PerpetuumSoft.Reporting.Silverlight.Se ~

=[] #

(Name) ReportServicel
ImageDPI 9

Language (Default)
Localizable False
ReportCache

ReportManager (none) v }

ThumbnailSize

,,,,,,

reportManager] [}
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Step 5. Creating a Report

1) Now we will create a report. To do this, run Report Manager Editor by right clicking
reportManagerl and choosing Run Editor option.

‘.'.v' S (A S e I 3 ;XIE
o
2% dataSet1 . reportManager1
' <> View Code F7
3 Cut Ctrl+X
ol Copy Ctrl+C
Paste Special ’
X Delete Del
&  Properties

A Report Manager editor will appear.

o

Repots | Data sources |

Add Delete Run Designer

0K Cancel

Before we start creating a report template we need to add a data source from which the report will be
generated.

2) To do this, we need to add Customers table to the Data binding list located on the “Data sources”
tab. Click “Add” button, specify ‘Name’ value as ‘Customers’ in the appeared “Edit object name”
form and select ‘dataSet1.Customers’ from the combo box list.
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al ReportManager editor =

\ ReportsJ Data sources |

Data bindings list

Name | Customers

Value |[TEES) [v| [ pataSource only
{none) ‘ N
‘ | |

customers
dataColumn
1dataColumn2
dataSet1

dataSet 1 Customers
reportManager1
ReportService 1

Edit Delete

OK || Cancel

In the “Reports” tab, add a new object — “InlineReportSlot” by clicking the “Add” button.

ol ReportManager editor =

Reports | Data sources |

Add Delete Run Designer

FileReportSlot

| InlineReportSlot %_\

UrlReportSlot




PERPETUUM
www.perpetuumsoft.com

Set the ReportName property value to CustomersReport. ( Note: you will get the required document from the
Report Manager exactly by that name).

Fepors [figasees
p , inlineReportSlot1 %l | =

#  Report name = CustomersReport
4 Design

(Name) inlineReportSlot 1
GenerateMember True

Modiffiers Private

Misc

Document Document
ExceptionMode Waming
ReportName

Report Script Type

Then press the “Run Designer” button to launch Report Designer.

inlineReport Slot 1
GenerateMember True
Modifiers Private
4 Misc
Document Document
ExceptionMode Waming
ReportName CustomersReport
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In the opened Report Designer window select the File\New menu item, and the form shown on the screen
below will appear.

=) (¢ 0. . ¥  SharpShooter Reports Designer

Home Insert Layout View
% E -

II=. New Ctrl+N =
s A A A

~ = = =

Z- 7 Open Cirl+0 it & | Alignment

o

i

I

'% Select Language

[ﬁ Settings | X Exit Designer

In the opened Wizards Gallery select Standard Report in the “New” tab and press OK.

o§ Wizards Gallery X

New ‘ Saved

Blank C# Report

Blank Visual Basic Report
| Standard Report

Pivot Table Report

Load Wizard OK Cancel

The Standard Wizard window will appear on the screen.

Set document parameters as shown in the following picture and add a data source using the “Add” button (“ﬂ’

).
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Iy Standard wizard 2
es Common
‘:}i}:‘) | H ‘ —’il Q Report template properties
"~ Common V| Show title Customers

Measure unit  Centimeter

Stylesheet  None
Script language g

Page properties

Size Orientation —  Page numbers
Paperkind A4 % ® Portrait Position  Header ¥
Pagesize (0;0 Landscape Align Right e
Columns layout
Columns count |1 B
Columns gap 0.000 5l
Save Preview template OK Preview document Cancel

Click """ 'button, select “Customers” by double click in the appeared tree view.

53 Standard wizard X3
Pages ——— | (DataSection)
+ X | H | Q q Data source @
j -

¢~ Common Pkt vl | £o0e)
.. (DataSection) z "
All fields — k

Caption
Width Aggregate
Save Preview template OK Preview document Cancel

Select the fields you want to output in the report (for example, both fields Name and Phone):
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By Standard wizard =
Pagegs —————  Customers
4 X | H | aa Data source  Customers
Field layout |List M|
GRS =} | Visible fields | Groups
Field name Caption Width  Aggregate
Name Name 100 None
Phone Phone 100 None

Caption  Phone

Width |100 Aggregate  |None M
Save Preview template ‘ oK Preview document Cancel

_|

hen press “OK” to create a template.

| Insert Layout View Document

R 2| & F - Ay Edit Style
TR s || AGBDCe AGBDCe AGBDCH gl

; — | Alignment = ‘ =l
> AR ‘A ‘A( o Margin HeaderFo... HeaderFo.. HeaderFo.. R

Font £ Styles

2 % | Properties
document! Document

ME

'J\“‘ge‘

T
L

GraphicsSettings PerpetuumSoft. Reportir
| MasterReport

<DocumentTitle> ShowObjsctBoul Tus

Behaviour

DoublePass False

InvalidRenderLe ThrowException

Design

Jpne Name document 1

T —— = Grid Settings

F ;stData(‘Customers.Phone > GrdStep 0.5 cm

ShowGrid True

SnapToGrid True

[ T TR N T - T © T TR S PR B S B S|

Grouping

DefaultGroupNa

Misc ‘
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DeleteEmptyPac False

CommonScript
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Allows you to declare global script variables a...

pagel / ¢ ] Prope... % DataSo... ‘ Document...

‘@ Error List
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Now save the template and close the Designer.

™ [d,[® ¥ documentl - SharpShooter Reports Designer

Home Insert Layout View Document
v ] M Fi
Rt AaBbCc AaBbCe AaBbCe
New Ctrl=N i} Border
nent it HeaderFo... HeaderFo.. HeaderFo.. -
2 7 Open Curl+0 Appearance l Styles
1] 4
Save h Ctrl+S ﬁl =
1819110 112 1 131 140 151 161 17 1 181 19 J[%]
% Save As... Ctrl+Shift+S = i
'6‘\' Select Language ey
A D
[}, Settings | X Exit Designer ’

3 <Document. Title=

. ' .
K csaSanat [=] -

i Resden Header

& LfTne Jrppne !

Z cesaiit Detai

B 'L'.f:3tData('Customers.Name")> _:_-:’fgatData('CustomersPhone“)> _,'
T -

E pagaFocterFagesocter

I w

Step 6. Adding and Setting Up a Silverlight ReportViewer component.

1) Now it’s time to add a Report Viewer component to our Silverlight application to be able to display a
report. In order to do that, we should add a reference to PerpetuumSoft.Reporting.Silverlight.Client
assembly which contains ReportViewer. Right click ‘References’ of the SilverlightApplication project in
the ‘Solution Explorer’ and choose’ Add Reference’ item in the popup menu.

@ eo-2udd »R

Search Solution Explorer (Ctrl+2) yel

fa] Solution 'SilverlightApplication’ (2 projects)
4 & SilverlightApplication
Properties

b K

¥ u-m

Add Service Reference... !! i

i Manage NuGet Packages...

53 Copy References

Scope to This
New Solution Explorer View

Sclution Explorer Team Explorer
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The library is located in the \SilverlightBin folder of the installed product.

Reference Manager - SilverlightApplication ?
b Assemblies Search Browse (Ctrl+E) Pl
b Solut Select the files to reference...
4 Brow @ v 1 |, « SharpShooter Collection » SilverlightBin v ¢ Search Silver... 0
Rece
Organize v New folder =~ [l @
[ Documents A Name : Date modified
J’ Music - ARt z
= |%| PerpetuumSoft.Reporting.Silverlight.Client.dll 30.04.2013 2:4¢
|&=| Pictures
% Videos
1% Computer
i Local Disk (C)  , <
File name: ' PerpetuumSoft.Reporting.Silverlig v 1 Executable Files (*.dll) v
. Add v Cancel
1 >
I Browse... l | OK | I Cancel ’

4 Assemblies Targeting: Silverlight 5 Search Assemblies (Ctrl+E) R ~
Framework Name “ Name:
B System.Windows.Controls. Theming.Expressic 3

System.Xml.Ling

Recent System.Windows.Controls.Them?ng.ExPr.essio Created by:
System.Windows.Controls. Theming.RainierOi Microsoft Corporation
b Solution System.Windows.Controls.Theming.RainierPt Version:
System.Windows.Controls. Theming.ShinyBlu 5.0.5.0
b Browse System.Windows.Controls.Theming.ShinyRec File Version:

System.Windows.Controls. Theming.SystemC 5.0.61118.00 built by: SL_V5_RTW
System.Windows.Controls. Theming.TwilightE
System.Windows.Controls. Theming.WhistlerE
System.Windows.Controls. Toolkit
System.Windows.Controls. Toolkit
System.Windows.Controls. Toolkit.Internals
System.Windows.Controls. Toolkit.Internals
System.Windows.Data
System.Xml.Ling
System.Xml.Serialization
System.Xml.Utils
System.Xml.XPath

Browse... |[ OK ‘4| Cancel
]A.
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After that, open MainPage.xaml in the Designer and add “rss” xml namespace for the
PerpetuumSoft.Reporting.Silverlight.Client assembly as follows:

xmins:rss="clr-
namespace:PerpetuumSoft.Reporting.Silverlight.Client;assembly=PerpetuumSoft.Reporting.Silverlight.Client"

Solution Explorer v

@ o-2ndBd #R&A -

Search Solution Explorer (Ctrl+;)

fal Solution 'SilverlightApplication' (2 projects)
4 ;@‘ SilverlightApplication

b Properties

p =B References

b Y Appxaml

b MainPage.xami
— = - TS ¢ Open I
4[] SilverlightApplication.Wel _
b M Properties Open With...
P =B References Open in Blend...
B ClientBin . Open Command Prompt
P =@ ReportServicel.svc
LT Silverlight.js [Z# Open Containing Folder
&) SilverlightApplicationTe Copy Path
SilverlightApplicationT
8 RO T e Gade F7
Solution Explorer  Team Explorer
Properties o i
Scope to This
MainP. I File Properti
- i i i New Solution Explorer View
o=-m. 1 =

95.25% ~ [fx]mm mEi[¢] P <
03 Design t E XAML
El<UserControl x:Class="SilverlightApplication.MainPage”
‘ xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"
mc:Ignorable="d"
xmlns:rss="clr-namespace:PerpetuumSoft.Reporting.Silverlight.Client;assembly=PerpetuumSoft.Reporting.Silverlight.Client”
d:DesignHeight="300@" d:DesignwWidth="400">

=] <Grid x:Name="LayoutRoot" Background="White">
</Grid> I

;</UserControl>

Then add ReportViewer element to the Grid Section.

<rss:ReportViewer x:Name="ReportViewerl1"
ServiceUrl="http://localhost:5555/ReportServicel.svc"
ReportName="CustomersReport"/>
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After you made changes the UserControl section should look like this:

No report to display -

« »

-of 100 100% ——M—

95.25% ~ [fx]mmE mE[-] @ ¢

0 Design 1 B XAML
Fl<UserControl x:Class="SilverlightApplication.MainPage"
xmlns="http://schemas.microsoft.com/winfx/2@06/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"
xmlns:d="http://schemas.microsoft.com/expression/blend/2008"
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"
mc:Ignorable="d"
xmlns:rss="clr-namespace:PerpetuumSoft.Reporting.Silverlight.Client;assembly=PerpetuumSoft.Reporting.Silverlight.Client”
d:DesignHeight="300" d:DesignWidth="480">
<Grid x:Name="LayoutRoot"” Background="White">

<rss:ReportViewer x:Name="ReportViewerl"

ServiceUrl="http://localhost:5555/ReportServicel.svc"
ReportName="CustomersReport”/>
</Grid>
</UserControl> I

After that, open MainPage source code and change/add the lines to make code look like this:

P Ll Appxami

b [%) MainPagexami P

— 0
4 [ SilverlightApplication. S

b S Properties Open With...

p =B References Open in Blend...
W ClientBin B Open Command Prompt

P =@ ReportServicel.svc
LT Silverlight.js & Open Containing Folder
@) SilverlightApplication Copy Path

N SilverlightApplication

Solution Explorer  Team Explorer

[& View Designer Shift+F7
PO s et The
MainPage.xaml File Properties New Solution Explorer View
» Exclude From Project

Build Action

Run Custom Tool
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public partial class MainPage : UserControl

{
public MainPage()
{
InitializeComponent();
Loaded += new RoutedEventHandler(MainPage_Loaded);
}
void MainPage_Loaded(object sender, RoutedEventArgs e)
{
ReportViewerl.RenderDocument();
}
}
MainPage.xaml.cse # X
#3 SilverlightApplication.MainPage ~ @, MainPage_Loaded(object sen

=lusing System;
using System.Collections.Generic;
using System.Lingq;
using System.Net;
using System.Windows;
using System.Windows.Controls;
using System.Windows.Documents;
using System.Windows.Input;
using System.Windows.Media;
using System.Windows.Media.Animation;
| using System.Windows.Shapes;

Finamespace SilverlightApplication

‘%{ public partial class MainPage : UserControl
‘ 1
El public MainPage()
i
InitializeComponent();
Loaded += new RoutedEventHandler(MainPage_Loaded);
¥
é: void MainPage_Loaded(object sender, RoutedEventArgs e)
¢ ReportViewerl.RenderDocument();
¥
, ¥
L}

Note: RenderDocument() invocation leads to the rendering of the current report on the server and displaying it
in the Report Viewer.

Step 7. Launching an Application.

1) To launch our application we need to set the SilverlightApplication.Web project as a StartUp. In order
to do that, right click SilverlightApplication.Web and select ‘Set as StartUp Project’ in the popup menu.
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@ o-20dd *RA -
Search Solution Explorer (Ctrl+;)
R1 Solution ‘SilverlightApplication' (2 pi I:.l Build
b & SilverlightApplication Rebuild

b [ml SilverlightApplication.Web

Clean
Publish...
Run Code Analysis

Q

|

View in Browser (Internet Explorer)

Convert to Web Application

View in Page Inspector Ctrl+K, Ctrl+G
Check Accessibility...

Open Command Prompt

Edit Project File

FREGS

Selution Explorer | Team Explorer Copy As Project Reference

*{} Remove and Sort Usings

Properties

SilverlightApplication.Web Project Prop Copy Path

BE: &~ Scope to This
Always Start When Debugging New Solution Explorer View
Project File Calculate Code Metrics

BOHECERE s Project Dependencies...

Project Build Order...
Add »
Add Reference...
Add Service Reference...
B Manage NuGet Packages...

#3  View Class Diagram

Then launch an application by clicking the “Start Debugging” 4 button on the main Visual Studio toolbar.

Dd SilverlightApplication - Microsoft Visual Studio
FILE EDIT VIEW PROJECT BUILD DEBUG TEAM TOOLS TEST

Qe - O - 9 - - Entemet Explorer = Debug -
Toolbox =+ v I X MainPage.xamlcs e & X L\\?

The popup message indicating that the Development server has been started on port 5555 will appear in the
system tray.

© ASP.NET Development Server % %
http://localhost:5355/

And the report rendering progress bar is displayed.
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Rendering...

As a result, we will have our sample report presented.

@ lightApplication - Windows Internet Explorer

| @ http://localhost:5555/ S;I\erhg Jo N ¢/ I

@ SllverllghtAppllcatlon

SharpShooter Reports.Silverlight - Unregistered version Buy now |
Customers
Name Phone
Johnson Leslie 613-442-7654
Fisher Pete 401-609-7623
Brown Kelly 803-438-2771 —

Conclusion

We have examined the basic steps and got a simple and quite operable application. In our case we did not
have to write thousand lines of code — we just used a ready-made implementation. In most cases this will be
enough. If you require a more complex behavior than the one provided in this sample, you can change a lot of
aspects in SharpShooter Reports.Silverlight operation as well as the appearance of the Report Viewer itself.

If you have any questions regarding the SharpShooter Reports.Silverlight integration don’t hesitate to contact
us at support@perpetuumsoft.com
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